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CHAPTER 1
Welcome
e

Welcome to the Web TimeSheet Integration Manager for Microsoft Project Server User Guide. Throughout
this user guide, the Web TimeSheet Integration Manager for Microsoft Project Server will be referred to as
the Integration Manager.

About the Integration Manager

The Integration Manager allows users to update project/task information, project team assignments, and
timesheet data between Web TimeSheet and Microsoft® Project® Server easily and efficiently. Once in-
stalled, the Integration Manager is accessible from the Web TimeSheet folder in the Start menu on the us-
er's local machine.

The Integration Manager allows one-way transfer of timesheet/hours data from Web TimeSheet to Microsoft
Project. Bidirectional data transfer is available for project/task information and project team assignments.
Bidirectional project/task information includes:

» Project/task structure

* Project manager

» Task estimated cost, with roll-up to the parent level
* Task start and end dates

The project start and end dates can be transferred one way, from Microsoft Project to Web TimeSheet (these
dates are automatically determined in Microsoft Project based on the task start and end dates).

Technology

The Web TimeSheet Integration Manager for Microsoft Project uses streaming XML (Extensible Markup
Language) technology, Microsoft Project Object Model, PDS (Project Data Service) and PDS extensions to
update data between Web TimeSheet and Microsoft Project. The Integration Manager establishes a link
with both the Web TimeSheet database and the Microsoft Project database and transfers data depending
on the specified criteria.

About this User Guide

This user guide provides information on installing and using the Integration Manager. The information is or-
ganized into chapters and a table of contents is provided for quick reference.

Document Conventions

This user guide uses the following conventions:

» References to other areas in the document are shown in italics and in blue to indicate they are
active links internal to the document. To automatically navigate to the section being referenced,
select the link.

« Hyperlinks to websites or e-mail addresses are shown in blue and underlined to indicate they are
active links external to the document. To open a new browser window to the website or to send an
e-mail to the address, select the link.
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« Key information is highlighted using a blue background for quick reference. An icon is used to indi-
cate the type of information being provided, as follows.

« The [ icon indicates a note, which provides a reminder of an important requirement or
further details on how the software operates.

+ The A icon indicates a warning notice. Warnings point out features or actions that can
have negative results if used incorrectly.

« The [ icon indicates a tip or hint designed to assist you in using the product more effi-
ciently.

[ The online help system uses these same conventions for easy identification of important
notes, warnings, and tips.

Contacting Support

If require further assistance configuring or using the Integration Manager, please contact Replicon's Cus-
tomer Support team using one of the following methods:

Direct Phone: 403-262-6519 ext 2
Toll-Free Phone:
North America: 1-877-862-2519 ext 2
Europe/New Zealand: 00-800-8622-5192 ext 2
Australia 0011-800-8622-5192 ext 2
E-mail: support@replicon.com
Web-Based Form: http://www.replicon.com/Support/RequestHelp.aspx
Fax: 403-233-8046
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CHAPTER 2

Getting Started
e

This chapter provides information on where to download the Integration Manager, starting the module once
it is installed, troubleshooting connection issues, understanding log files, and accessing the online help.

System Requirements

To use version 4.6 or higher of the Web TimeSheet Integration Manager for Microsoft Project Server, each
client machine must meet the requirements listed below.

Operating System One of the following, with Administrator access for installation:

*  Windows 2000 Professional with Service Pack 4 or higher
e Windows 2000 Server with Service Pack 4 or higher

«  Windows 2003 Server with Service Pack 1 or higher?

+  Windows 2008 Server R22

» Windows XP Professional with Service Pack 1 or higher?
»  Windows Vista Business or Enterprise?

»  Windows 7 Professional or Enterprise®

Hardware e Pentium 500 MHz CPU or equivalent
* 512 MB memory
» 50 MB available disk space
e Screen resolution of 1024 x 768 or higher

Software * A high-speed connection to a compatible version of Web
TimeSheet
* A browser that supports both Microsoft Project Web Access
and Web TimeSheet

* Microsoft Project Server 2003, 2007, and for integration
manager version 4.7.3 and higher only, Microsoft Project
Server 2010

All projects should be saved in a Microsoft Project server
installation

a.For versions 4.7.3 and earlier of the integration manager, only the 32-bit version is supported

Downloading and Installing the Integration Manager

The Web TimeSheet Integration Manager for Microsoft Project can be downloaded from within the Integra-
tions section of Web TimeSheet. Refer to Installing an Integration Manager in Web TimeSheet’s online help
for information on installing the integration module.

[ Automatic Updates...
As of Version 4.4, the first time you launch the integration module after an upgrade becomes available,
your version will be automatically upgraded.
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Configuring Microsoft Project Server

Before you launch the Integration Manager, you must configure Microsoft Project Server to ensure that the
Integration Manager can transfer data.

Configuring Microsoft Project Server 2007 or 2010
To configure Project Server 2007 or 2010:

1. Log in to Microsoft Project Web Access.

[ Forinformation on accessing the Web Access interface, contact your system administrator or
refer to Microsoft Project’'s documentation.

Select Settings > Server Settings from the side menu.
From under Time and Task Management, select Task Settings and Display
From the Tracking Method row, select the Hours of work done per period option.

ok D

From the Reporting Display row, select Resources should report their hours worked every
day.

o

Select Save.

7. If you are using Project Server 2010, select Settings > Additional Server Settings from the side
menu.

8. From the Task Mode Settings row, select Automatically Scheduled.

[ The Automatically Scheduled setting is recommended since the Integration Manager does
not support the transfer of manually scheduled tasks from Microsoft Project 2010. If you don’t
want all tasks to be manually scheduled, you can modify this setting on a per task basis in-
stead.

9. Sign out of Microsoft Project Web Access.

[ Any changes made to the Microsoft Project server configuration will only apply to projects added to
the server after the changes.

Configuring Microsoft Project Server 2003

To configure Project Server 2003:

1. Log into Microsoft Project Web Access.

For information on accessing the Web Access interface, contact your system administrator or refer
to Microsoft Project’s documentation.

Select Admin from the top menu.

Select Server configuration.

Select the Enable enterprise features option.
Select Save Changes.

Select Customize Project Web Access.

No g s~

Under Specify the default method for reporting progress on tasks, select Hours of work done
per day or per week....

8. Under Time period settings, select:
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 Non Managed Periods
* Resources should report their hours worked every day

9. Inthe Maximum number of hours that can be entered per day for a single task field, enter O if
you do not want to limit the number of hours that can be entered.

[ Changing this setting is typically unnecessary; however, if you leave the field set to a specific
number of hou8-9rs, errors may occur during data transfer under some conditions.

10. Select Save Changes.
11. Log off of Microsoft Project Web Access.

[ Any changes made to the Microsoft Project server configuration will only apply to projects added to
the server after the changes.

Updating Automatic Update Service User Account Information

If you need to update the Automatic Update service login information after installing the Integration Manager:

1. Open Windows’ Services window.
2. Double-click the MSPI AutoUpdate service entry.

3. Select the Log On tab. On this tab, the This account option should be selected, displaying the cur-
rent account login information.

. Update the account user name and password information, as required.
5. Select OK.

Starting the Integration Manager

[ Before launching the Integration Manager, ensure Microsoft Project Server is configured correctly, as
detailed in Configuring Microsoft Project Server on page 8.

The Integration Manager must be installed on your local computer in order to transfer data. Once installed,
you can access the Integration Manager by following the steps below:
1. From the Windows Start menu, select Integration Manager for Microsoft Project Server.
A Setup for Web TimeSheet Integration Manager window displays.

[ The Integration Manager is typically located inside the Replicon Inc folder; if you cannot find
it, ask your system administrator where it was installed.

2. Modify, if desired, the following Microsoft Project Server information:
* Server location

» User name and Password (only required if you are using Project Server account authenti-
cation)
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» Project Server account option:

Project Server Select this account type option if...
account option

Use Windows Microsoft Project Server is set up to use your Win-
user account dows account information.

Selecting this option ensures that if you change your
Windows login information, the Integration Manager
will recognize the new information and still allow you

to log in.
Use a Project You are using a unique user name and password in
Server account Microsoft Project Server (not your Windows account
information)

3. Enter (or modify, if desired) the following Web Timesheet Connection information:

 The Web TimeSheet URL, which is used to access Web TimeSheet on the server. If you
are unsure of the URL, check with your system administrator.

*  Your Web TimeSheet Login name or Password you normally use to log in to Web
TimeSheet.

« If you would like your Web TimeSheet connection information to be saved, enable the
Remember this information check box. You will still be able to change your login infor-
mation, if necessary, from the Configuration tab within the Integration Manager.

4. Select the OK button to connect to Web TimeSheet. If the connection is successful, the Integration
Manager will open in a new window. If the connection fails, refer to Possible Reasons for Connection
Failure on page 10 below for more information.

[ You can change your setup information later, if necessary, from the Integration Manager's Configu-
ration tab. For more information on how to do this, refer to Chapter 6, Modifying Configuration Set-
tings on page 26.

Possible Reasons for Connection Failure

If you are unable to connect to Web TimeSheet, the Integration Manager will display an error message indi-
cating the reason why the connection failed. Possible reasons for a failed connection include:

* User Name/Password Error
Your user name does not exist, your user profile has been disabled, or your password is invalid. If
you cannot resolve the issue on your own, please contact your Web TimeSheet administrator.

e License Error
You do not have a valid license key and/or seat assignment for the Web TimeSheet Integration
Manager for Microsoft Project Server, or your license key has expired. Please contact your Web
TimeSheet administrator for further information.

e Server Connection Error
The server location is invalid, or there is a problem connecting to the Web TimeSheet server.
Please contact your system administrator for further information.

e Interrupted Connection
The connection to the Web TimeSheet server has been interrupted. The Integration Manager will
automatically try to reconnect before requiring feedback. If you receive this error, you may choose
to retry, or cancel the connection and try again later.
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Understanding the Integration Manager Log Files

The Integration Manager generates two log files that are available for viewing at any time:

Log File Name

This file is typically located at...

Contains all information logged...

MSPIlog.txt

In XP or earlier:

C:\Documents and Settings\<logged-
in user's name>\Local Settings\Appli-
cation Data®\Replicon\Integration
Manager for Microsoft Project

In Vista:
C:\Users\<logged-in user's name>\Ap-

pData®Local\Replicon\Integration
Manager for Microsoft Project

... before the Integration Manager logs in
to Web TimeSheet (for example, infor-
mation regarding login failures)

AND

all information logged after the Integra-
tion Manager connects to Web
TimeSheet (for example, information on
all events that occurred during the trans-
fer process, including errors encoun-
tered and items that were not updated
due to problems with Web TimeSheet
editing permissions)

MSPIService.txt

In XP or earlier:

C:\Documents and Settings\All Us-
ers\Application Dataa\Replicon\Inte-
gration Manager for Microsoft
Project\Auto Update Log Files

In Vista:

C:\ProgramDataa\Replicon\Integra-
tion Manager for Microsoft Project\Au-
to Update Log Files

... during auto updates (actions and
logs)

a. Application Data, AppData , and ProgramData are by default hidden folders, so you will have to en-
able the Show hidden files and folders option in your operating system to view them. To find this op-
tion in Windows XP or earlier, select Tools > Folder Options... > View. To find this option in Vista,
select Organize > Folder and Search Options > View.

Getting Started
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Accessing the Online Help

The Integration Manager includes an online help system that provides comprehensive information on using

the software to complete key tasks, as shown below.
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To access the online help, select the Help button in the bottom, right hand corner of the main Integration
Manager window.

Help
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CHAPTER 3
Transferring Data
]

The Web TimeSheet Integration Manager for Microsoft Project Server allows you to transfer data between
Web TimeSheet and Microsoft Project Server.

This chapter provides information on:

«  Setting up the Integration Manager before performing a transfer. For more information on this topic,
refer to Setting Up the Integration Manager on page 13.

e Saving transfer settings. For more information on this topic, refer to Saving Transfer Settings on
page 17.

« Performing a transfer. For more information on this topic, refer to Performing a Transfer on page
18.

M The Integration Manager does not support the transfer of manually scheduled tasks from Mi-
crosoft Project 2010. Therefore, ensure any tasks you wish to transfer are set to auto scheduled.

Setting Up the Integration Manager

Before you can transfer data (using the procedure described under Performing a Transfer on page 18), you
first need to specify some setup options to ensure that the proper data is updated and the field mappings
are appropriate.

[¥] Once you have set up a data transfer, you can save your settings and use them for future transfers,
or as a starting point for making modifications to the settings. You can save multiple data transfer con-
figurations.

* For information on saving your settings, refer to Saving Transfer Settings on page 17.

e Forinformation on loading a previously-saved configuration file, refer to Chapter 6, Modifying
Configuration Settings on page 26.

To set up the Integration Manager, you must:

1. Select the direction of transfer, and the projects you would like to update. For information on doing
this, refer to Selecting General Update Settings on page 13.

2. Select the data you would like to update. For information on doing this, refer to Selecting Data to
Update on page 14.

3. Perform resource mapping, if required. For information on doing this, refer to Performing Field Map-
ping on page 17.

4. Perform field mapping. For information on doing this, refer to Performing Field Mapping on page 17.

M To prevent data conflicts, when transferring from Web TimeSheet to Microsoft Project, start and end
dates, task duration and type, and time entries are not updated for projects and tasks that have sub-
tasks ("child" tasks). Data for these “parent” tasks is updated based on the entries of their “child” tasks
in Microsoft Project.

Selecting General Update Settings

Select the direction of transfer and which projects you would like to update using the General tab.
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Selecting the Direction of Transfer

Use the Select Direction To Update Data field (of the General tab) to select one of the following options:

e Transfer data from Microsoft Project to Web TimeSheet
» Transfer data from Web TimeSheet to Microsoft Project

Selecting Projects to Update

Use the Select Projects To Update field (of the General tab) to select the projects you want to update. If
you are transferring data:

« From Web TimeSheet to Microsoft Project, you can select any number of the projects available
within Web TimeSheet.

] If you would like only projects with Open status in Web TimeSheet to display, enable the Hide
closed projects check box. When this option is enabled, all closed projects will disappear
from both the Available and Selected projects lists.

* From Microsoft Project to Web TimeSheet, you can select any number of the projects available
in the Microsoft Project Server installation.

[ Only projects published in Microsoft Project will display in the Integration Manager’s project
selection list.
To select projects to update:

1. Select the Refresh List button to ensure the list of available projects is up to date.

2. Select a project, or multiple projects, from the Available Projects list on the left. To select multiple
projects, hold down the Ctrl key while selecting the project names.

3. Select the 5 button to add the selected projects to the Selected Projects list on the right.

A The Integration Manager does not support the transfer —in either direction — of projects that have been
assigned multiple clients using the Bucket method or Project cost allocation options.

Selecting Data to Update

Specify the types of data you would like to transfer using the Select Data to Update tab. Depending on the
direction of transfer, only certain options outlined in the procedure that follows will be available.

Selecting Task Hours to Transfer

If you are transferring from Web TimeSheet, enable the Update Task Hours check box if you want to include
task hours in the update. Task hours cannot be transferred from Microsoft Project to Web TimeSheet. Only
hours that meet all selected criteria will be updated.

[ When updating for the first time, update all hours within the project start and end dates to ensure all
the necessary data is available in both applications.
To select task hours to transfer to Project:

1. From the Approval Status field, select one of the following:
« All hours (regardless of whether the time has been committed/approved)

Transferring Data 14



Use this option if you have a short project cycle or deadlines that fall outside the usual
timesheet due dates

Approved hours

Use this option if your project has a longer cycle (one for which the estimate vs. actual val-
ues do not require constant comparison).

[ Time will be updated only for resources that are set up explicitly as members of the
project team in Web TimeSheet (not members that receive their assignments via an
<Al I> or department assignment).

[ If you have added resources to your project, you should perform an update for the
project structure/resources before attempting to update any time.

2. Select the Date Range for the task hours, if applicable. The date range options are:

All

Transfers all dates for which hours have been entered into Web TimeSheet for the project.
If any of these dates fall outside of the estimated project start and end dates set in
Microsoft Project, they will be included in the transfer, and the project start and end dates
will be automatically updated to include these dates.

From/To (date range)
Timesheet Period
Time Data of

Select one of the following options:

Option Transfers time entered...

Current Week ... from the most recent Sunday to
the day prior to the transfer date. For
example, if you transfer data on
Wednesday, data from Sunday to
Tuesday will be included.

Previous Week | ... for the week — spanning Sunday to
Saturday — previous to that of the
transfer date.

[ If the transfer day is a Sunday, select Previous Week. If you select Current Week,
the time period will include zero days and no data will be transferred.

If the Integration Manager cannot read the users’ weekly days off from the Project cal-
endar, the days off are assumed to be Saturday and Sunday.

[y Transfers automatically adjust to use data from the selected relative time period.
Therefore, you do not need to adjust the date with each transfer.

[ When updating hours from Web TimeSheet to Microsoft Project, the Integration Manager calculates
the total actual work for the project. The Work field will not be affected by these calculations because
this field is automatically calculated by Microsoft Project based on multiple variables.

3. From the Transfer field, select to transfer one of the following:

Transferring Data
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Only modified and new time cells

All time cells

[ For information on how the Integration Manager handles transfers involving duplicate user names in
Web TimeSheet, refer to Understanding how Duplicate Users are Transferred on page 24.

Selecting Other Data to Update

Under Advanced Settings, select any other types of data you would like to update by enabling the appro-
priate check boxes.

The available options are:

Option Name

When enabled, transfers...

Notes

Project Man-
ager

Update ¢ Project and task names This data is updated by default during the
Project/Task «  The task sort order first transfer in either direction.
Structure . . . .
e Additional project/task information
selected in the field mapping
* Project start and end dates
Update e The Manager field in Project Transfer of this field is successful only if the

(located on the File > Properties >
Summary tab)

to or from...
e The Project Leader field in Web
TimeSheet

manager:

« s presentin the Web TimeSheet User
list

e Has Manager permissions

If you enable this option, you must specify
the name format in the Resource Name
Mapping field. For information on name for-
mats, refer to Chapter 5, Mapping Resourc-
es on page 22.

Update Task |+ The project or task's Start date field
Start Date in Project (located on the File >
Properties > Contents tab)
to or from*...
e The Time Entry Start Date field in
Web TimeSheet
Update Task |+ The project or task's Finish date
End Date field in Project (located on the File >

Properties > Contents tab)

to or from*...
e The Time Entry End Date field in
Web TimeSheet

* |f you are transferring a project from Web
TimeSheet to Microsoft Project, start and
end dates:

* ARE updated, if it is the first transfer of
that project. If you do not enable these
options, the date of transfer will be
transferred to these Project fields
instead

e« ARE NOT updated, if it is the second
(or subsequent) transfer of that project.
Not updating these fields in this direc-
tion prevents data conflicts.

Transferring Data
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Option Name | When enabled, transfers... Notes

Update « Employees who are project You may choose to transfer one of the fol-
Project Team resources in Microsoft Project lowing:
to or from... *  Only the resources for a project team

the project team members will be cre-
ated in the Web TimeSheet User list

* The resources and their task assign-
ments the project team members will be
created in the Web TimeSheet User list
and they will be assigned to the appro-
priate project/task

e Employees who are members of the
Web TimeSheet project team

If you enable this option, you must specify
the name format in the Resource Name
Mapping field. For information on name for-
mats, refer to Chapter 5, Mapping Resourc-
es on page 22.

Performing Field Mapping

Once you have selected which data you would like to transfer, you must then map applicable fields in Web
TimeSheet to their corresponding fields in Microsoft Project, or vice versa. You can set up mapping relation-
ships for only one update direction at a time — the update direction you selected on the General tab.

To set up a mapping relationship:

1. Select the Field Mapping tab.

2. From the drop-down list on the left, select a source application field name. This list contains all the
available fields in the source application.

3. From the drop-down list at the right, select the destination application field to map to the selected
source field. Once selected, a field is no longer available for mapping.

4. Select the Add button. The selected fields will display in the Selected Mapping Relationships list
box.

To remove a mapping relationship, select the relationship from the Selected Mapping Relationships list
box and select the Remove button.

For information on the available mapping relationships, refer to Chapter 7, Field Relationships on page 28.

Saving Transfer Settings

The data transfer settings you have selected can be saved to a file which can be loaded into the Integration
Manager to restore the configuration settings to the saved values.

A configuration file can also be specified as the default and automatically loaded when the Integration Man-
ager starts.

] If you regularly perform several different types of transfer, create a file for each configuration and load
each as required.
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The data transfer settings are saved in a configuration file with the extension .XML. The following settings
are saved in the configuration file:

Tab where data was selected Data saved in the configuration file

General The direction of data transfer
The projects selected for transfer

Select Data to Update All options selected

Field Mapping All field mappings selected

Configuration The Resource Pool Configuration settings selected
The Microsoft Project Server Information settings se-
lected

To save the current configuration settings:

4,
5.

Select the Save button. A Save Settings to File window displays.

Navigate to the location where you want to save the configuration file.

In the File name field, enter a name for the configuration file.

Select Save. A message box indicating that the settings have been saved displays.
Select OK to close the message box.

To load the settings saved in a configuration file into the Integration Manager:

1

2.

. Select the Configuration tab.
In the Load Configuration File field, use the Browse button to select the file you would like to load.

[ Any changes you make to the configuration settings are discarded when you select the Exit or the
Reset button. Changes to the settings are only saved when you select the Save button, and save your
current settings to a configuration file.

Selecting the Reset button refreshes the Integration Manager’s connection to Microsoft Project and
to Web TimeSheet; if you are using a default configuration file, your settings will revert to those saved
in the file.

Performing a Transfer

After

setting up and saving the options, you can perform updates at regular intervals without needing to re-

peat the setup process.

[ Werecommend that you set up projects in Microsoft Project, then transfer the data to Web TimeSheet.

When updating projects, only the first ten levels of the hierarchy will be updated.

To perform a transfer:

1.
2.
3.

Select the Review button. The Summary of Selected Options window launches.
Review your selected options, then select the OK button to close the window.

Select the Update Now button. The transfer will use all settings selected from the General, Select
Data to Update, and Field Mapping tabs.
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« Forinformation on the General tab settings, refer to: Selecting General Update Settings on
page 13.

« Forinformation on the Select Data to Update tab settings, refer to: Selecting Data to
Update on page 14.

* For information on the Resource Mapping tab settings, refer to: Chapter 5, Mapping
Resources on page 22.

« For information on the Field Mapping tab settings, refer to: Performing Field Mapping on
page 17.

When the transfer is complete, the Integration Manager will notify you if any errors or issues were encoun-
tered during the transfer and give you the option of viewing the log file.

[ If, according to the MSP110g. txt log file, your permissions prevented you from updating certain data,
refer to your Web TimeSheet administrator for more information.

For more information on the Integration Manager log files, refer to Chapter 2, Understanding the Inte-
gration Manager Log Files on page 11.

A You cannot cancel the transfer process once it has begun. If you choose to close the window before
the transfer is complete, the partially-transferred data will not revert back to its original state.

[ For information on how the Integration Manager handles transfers involving duplicate user names in
Web TimeSheet, refer to Understanding how Duplicate Users are Transferred on page 24.

Publishing and Updating Data on the Project Server
To make transferred projects visible in Microsoft Project:

* You will have to publish any projects that you transferred for the first time. To do this, from within
Microsoft Project:

a. Select Collaborate.
b. Select Publish.
c. Select All Information.
* You may have to update all transferred information. To do so, from within Microsoft Project:
a. From the Collaborate menu, select Update Project Progress.
b. Setthe Accept status of the transferred task, or select Accept All.
c. Select Update.

[ If you transfer a task that has a new assignment in Web TimeSheet to Microsoft Project, in
order to see all the new information in Microsoft Project, you may need to:

1. Transfer the project to Microsoft Project.

2. Publish the project.

3. Transfer the project to Microsoft Project a second time.
4. Update the information, as outlined above.

Refer to your Microsoft Project Server documentation for further information about publishing
to the server and accepting changes to projects and tasks.
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CHAPTER 4
Scheduling Automatic Updates
]

The Integration Manager can be configured to automatically transfer data. Automatic transfers can be sched-
uled to occur just once, or on a regular basis. You can schedule multiple automatic transfers, each with its
own configuration file and schedule.

[ Scheduled updates will occur even if the Integration Manager is not running at the time of the transfer.
You may open and close the Integration Manager while automatic updates are occurring without im-
pacting the update.

Scheduling an Automatic Update Action

To schedule an automatic update:

1.

10.

Enter the data transfer settings you want to use. For information on how to do this, refer to Chapter
3, Transferring Data on page 13.

Save the settings to a configuration file. For information on how to do this, refer to Saving Transfer
Settings on page 17.

Select the Automatic Update tab.
Check the Enable Automatic Updates check box.
Select New Action to create a new automatic update action.

[ You can create multiple actions. This allows you to update different projects at different times.

Enter a Name for the action.

Check the Enabled check box.

Only enabled update actions are carried out.

Use the Browse... functionality to select the configuration file saved in step 2.

[ You can preview the settings contained in the configuration file by selecting the Preview but-
ton.

From the Update Time drop-down list, select the time of day when the update should occur.

[ You can schedule multiple update actions to occur at the same time. The order of updates in
the Schedule Actions list box determines the order in which the updates occur. Use the arrow
buttons to adjust the order of the actions in the list box.

Specify whether the update should occur once or on multiple occasions:
To schedule an update to occur just once:

a. Select the Update once on option.

b. Select the date when you want the update to occur.
To schedule the update to occur on a regular basis:

a. Selectthe Update regularly starting on option.

b. Select the date when you want the first update to occur.

c. Specify the interval at which the update will occur:
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» For an interval measured in days, select the Every ... day(s) option and enter the

desired update interval in days.

« For an interval measured in weeks, select the Every ... week(s) on option and
enter the desired update interval in weeks. Then, select one or more days on
which the update will occur during each specified update week.

11. Select Save Action. The action will display in the Scheduled Actions list box, and the updates will

begin on the date you specified.

Editing an Automatic Update Action

To edit an automatic update action:

1. Select the action from the Scheduled Actions list box.

2. Make desired changes to the settings in the Scheduled Action Details section.
3.

Select Save Action. A dialog box displays:

« To overwrite the existing action with the new settings, select Yes.

» To create a new action with the settings, select No.

Disabling an Automatic Update Action

To disable an action so that the specified update does not occur:

1.
2.
3.
4,

Select the action from the Scheduled Actions list box.
Clear the Enabled check box.
Select Save Action to save the changes.

When asked if you want to overwrite the existing action, select Yes.

The update will not occur until the action is enabled again.

Deleting an Automatic Update Action

To permanently delete an action so the action is no longer available for use or editing:

1.

Select the action from the Scheduled Actions list box.

2. Select Delete Action.

Scheduling Automatic Updates
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CHAPTER 5
Mapping Resources
T

A resource name formula must be defined in the Integration Manager so that:

* When you transfer users and resources between Project and Web TimeSheet, the Integration Man-
ager can match each resource with the correct user.

« If the Integration Manager is creating a new user in the destination application, it can determine
what format to use when creating the new user’s details.

You can set the resource name formula and other resource transfer settings via the Resource Mapping tab,
using the fields outlined below.

Setting the Resources Options

Map Resources to Users using

Use this field to choose whether resources should be mapped using their name (Resource Name <--> User
Name) or their authentication settings (Windows Account <--> Login Name).

[ Both options are only available if Enable Windows NT/Active Directory login verification or Enable
SAML authentication is checked in Web TimeSheet's system preferences. If you use Web
TimeSheet authentication only, the Resource Name <--> User Name option will be selected by de-
fault.

Resource Name Formula

Use this field to specify the resource name formula. This formula determines the name format the Integration
Manager will use to match resources and their corresponding users. You can create a custom name formula,
or retain the default (JFirstName $LastName). The format options are:

Allowed Formula Tag... Web TimeSheet field
mapped to...

$FirstName First Name

$LastName Last Name

$LoginName Login Name

$Other** Does not map.

At minimum, the formula must include either $LoginName or both $FirstName and $LastName.

**Use the $Other tag to represent any other text in the resource name that does not correspond to anything
in Web TimeSheet. You may also include non-text special characters (such as ., () {}[]*) that do not map
to anything in Web TimeSheet.

[ When transferring from Microsoft Project to Web TimeSheet, ensure that you use the same resource
name mapping formula. If a resource who was previously transferred to Web TimeSheet is transferred
again using a different resource name mapping formula, the user will be duplicated in Web TimeSheet
using the new name format.
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Create a new user in Web TimeSheet if user does not exist

If a resource you are transferring from Project does not yet exist in Web TimeSheet, you can choose to cre-
ate that user in Web TimeSheet. You must have permission to add new users in Web TimeSheet to carry
out this transfer.

We recommend selecting this option:

» To ensure that all necessary information is transferred during the update process
« To prevent update delays while you wait for the necessary information to be added.

If you enable this option, you must supply the default authentication type and domain (if applicable) that you
would like assigned to the new user. Only authentication types enabled in Web TimeSheet will be available
for selection.

Understanding Settings Assigned to Newly-Created Users

The following settings are automatically assigned to new users created in Web TimeSheet.

Type of Setting Each new user created in Web TimeSheet will be assigned...

Permissions Non Exempt - Time and Time Off permission
Project & Billing seat assignment (and Time & Attendance, if available)

Password (if appli- | The password password

cable)

First Name A first name based on the $FirstName from the resource name formula, if avail-
able. If not available, the first name will be set to the $LoginName included in
the formula.

Last Name A last name based on the $LastName from the resource name formula, if avail-
able. If not available, the first name will be set to the $LoginName included in
the formula.

Authentication The authentication type selected in the Integration Manager.

type

Login name If Windows NT, Active Directory, or SAML authentication are selected, the Win-

dows Account login name value as their Web TimeSheet login name.

If Windows Account is not available, or Web TimeSheet Internal authentication
is selected, the Web TimeSheet login name will be set to the $LoginName in-
cluded in the formula. If $LoginName is not included in the formula, the login
name will be set to $FirstName$LastName.

Domain (if applica- | The domain from the user’'s Windows Account, if available. If not available, the
ble) user will be assigned the domain selected in the Integration Manager.

**This value can be reset manually after transfer if different domains are re-
quired in Web TimeSheet and Project.

Assign a Windows Account when creating resources in Microsoft Project

If a user you are transferring from Web TimeSheet does not yet exist in Project, you can choose to assign
these users a Windows Account when they are created in Project. If you enable this option, you must supply
the domain that you would like assigned to the new user, if this information is not available in Project.
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The following settings are assigned to new users created in Project.

Type of Setting Each new user created in Microsoft Project will be assigned...

Resource Name A name using their first, last, and login name details from Web TimeSheet, and
based on the resource name formula.

Windows Account | A Windows Account with the user's Web TimeSheet login name and domain. If
that domain is not available, the user's domain will be set to that entered in the
Integration Manager.

Setting the Resource Pool Updates Options

The Microsoft Project resource pool is a set of resources that can be shared by several projects, saved in a
Local resource data file.

Transferring Resource Pool members to Web TimeSheet

To transfer resources from the Microsoft Project resource pool to Web TimeSheet, select the Update Now
button.

Using Custom Fields when transferring Resources from the Resource Pool

You can set up custom fields in Microsoft Project for use when transferring new users’ from the resource
pool to Web TimeSheet. You can create and select custom fields for the users’ login name or password.

If you do not set up the custom fields, the Integration Manager will assign the login name and password as
outlined on Understanding Settings Assigned to Newly-Created Users on page 23.

Ay If Windows NT, Active Directory, or SAML authentication are selected in the Integration Manager, the
login name will be based on the Windows Account value, if available, and not the custom field value.

Understanding how Duplicate Users are Transferred

It is possible to create two or more users with the same user name in Web TimeSheet; however, the dupli-
cate users’ login names must be unique.

[ Microsoft Project does not allow users with the same user name to be created.

Refer to the table below for information on how the Integration Manager handles transfers involving dupli-
cated users.

If you attempt to transfer... The Integration Manager will...

... users that are duplicated in Web TimeSheet | ... automatically append, in brackets, the user’'s

to Microsoft Project, when none of the duplicat- | login name to their last name in Project. This will

ed users exist in Project happen even if only one of the duplicated em-
ployees is transferred.
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If you attempt to transfer...

The Integration Manager will...

... users that are duplicated in Web TimeSheet
(or their data) in either direction, when that em-
ployee’s user name exists — but has not been
appended with their login name — in Project

Note: This situation may arise if, for example,
you transferred a user to Project before creating
a duplicate in Web TimeSheet, or if you created
a user who was duplicated in Web TimeSheet
independently in Project (this is not recom-
mended).

... hot transfer the duplicated users/data, and an
error will be logged, since the user’'s data in
Project may correspond to any of the duplicated
users in Web TimeSheet.

In this case, you may manually append the us-
er’'s login name to their last name in Project, and
then transfer the user/data.

Mapping Resources
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CHAPTER 6
Modifying Configuration Settings
]

Use the Configuration tab to modify these configuration settings, as required:

Configuration Section
Name

Use this section to specify...

For information on these set-
tings, refer to...

Web TimeSheet Server
Connection

The location and authentication
information for the instance of

Web TimeSheet you want to
connect to

Modifying your Web TimeSheet
Server Connection on page 26

The location and authentication
information for the instance of
Project Server you are using

Microsoft Project Server In-
formation

Modifying your Microsoft
Project Server Information on
page 26

Which file containing previous-
ly-saved settings to use

Configuration File

Modifying Configuration Set-
tings Information on page 27

What action the Integration
Manager should take when an
error occurs

Prompt Message Options

Modifying the Action the Inte-
gration Manager takes when an
error Occurs on page 27

Modifying your Web TimeSheet Server Connection

Modify, if desired, the following Web Timesheet Server Connection information:

« The Web TimeSheet URL, which is used to access Web TimeSheet on the server.

e Your Web TimeSheet Login name or Password.

« If you want to connect to Web TimeSheet to begin updating data or to test the new connection,
select the Connect button.

« If you want the Integration Manager to save your Web TimeSheet connection information so you do
not have to re-enter it next time you log in, enable the Remember this information check box.

Modifying your Microsoft Project Server Information

Modify, if desired, the following options in the Microsoft Project Server Information section:

* Server location

« User name and Password (only required if you are using Project Server account authentication)

« Project Server account option:

Project Server ac-
count option

Select this account type option if...

Use Windows user

account formation.

formation and still allow you to log in.

Microsoft Project Server is set up to use your Windows account in-

Selecting this option ensures that if you change your Windows lo-
gin information, the Integration Manager will recognize the new in-
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Project Server ac-
count option

Select this account type option if...

Use a Project Serv-
er account

You are using a unique user name and password in Microsoft
Project Server (not your Windows account information)

Modifying Configuration Settings Information

In the Microsoft Project Configuration section:

« If you want to load the settings from a previously-saved .XML configuration file, use the Browse

button to locate and select the file.

The Integration Manager will automatically update its configuration settings using those stored in
the file. For more information on saving configuration settings, see Modifying the Action the Inte-

gration Manager takes when an error Occurs below.

» Enable the Use this file as the default Configuration check box if you would like the selected

configuration file to load by default when the Integration Manager is launched.

Modifying the Action the Integration Manager takes when an error

Occurs

To modify the action the Integration Manager takes when an error occurs:

In the Prompt Message Options section, in the When error occurs during data transfer field, select the
action the Integration Manager should take when an error occurs. The options are described in the following

table:

Option

The Integration Manager...

Prompt

Prompts you to choose between continuing and aborting the trans-
fer

Continue Transfer

Automatically continues the transfer

Abort Transfer

Automatically aborts data transfer

Modifying Configuration Settings
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CHAPTER 7
Field Relationships
e

On the following pages, the field mappings available when transferring from Web TimeSheet to Microsoft
Project and when transferring from Microsoft Project to Web TimeSheet are provided.

Important Notes on Mapping Fields

Keep the following in mind when selecting field mappings:

» For Microsoft Project Server, mapping is available to project/task specific custom fields at the
enterprise level only. Custom fields set up in your local version of Microsoft Project are not avail-
able for mapping.

*  When you map from Microsoft Project custom fields to Web TimeSheet user defined fields, calcu-
lated fields are excluded because Web TimeSheet user defined fields cannot perform calculations.

* Mapping between Web TimeSheet user defined fields and Microsoft Project custom fields is
dependent on the field type. This means that data transfer may fail if the data types are not compat-
ible. For example, a number field cannot successfully transfer data to a date field; however, a num-
ber field can successfully transfer data to a text field.

Available Mappings from Web TimeSheet to Microsoft Project

Web TimeSheet Field (source) Microsoft Project Field
(target)
Project Description Project Category

Project Keyword

Project Subject

Project Title

Project Comments

Project Author

Project Company

Enterprise Custom Fields (Project Type)

Project Code Project Category

Project Keyword

Project Subject

Project Title

Enterprise Custom Fields (Project Type)

Project Client Project Company
Enterprise Custom Fields (Project Type)

Task Code Enterprise Custom Fields (Task Type)

Task Estimated Hrs Task Work
Enterprise Custom Fields (Task Type)

Field Relationships 28



Web TimeSheet Field (source) Microsoft Project Field
(target)

Task Estimated Cost Task Cost
Enterprise Custom Fields (Task Type)

Notes:

*  Microsoft Project allows entry of the estimated cost only at the bottom level of the project/task
structure, therefore you should not enter estimated cost values for any parent projects/tasks in
Web TimeSheet. Values entered for higher level tasks will not be included in the update process.

*  Turn on the Project/Task Roll-up feature in Web TimeSheet before the first update is performed
from Microsoft Project to Web TimeSheet.
» The method Project uses to calculate Task Cost results in an inaccurate Task Cost value in
Project if, during the same update, you transfer both:
*  One or more new resource assignments, AND
» Task Estimated Cost to Task Cost
To prevent this inaccuracy, transfer new resources and cost mapping for a task in separate
updates.

If you have already transferred cost mapping and new resources for a task in a single update, re-
transfer the project from Web TimeSheet to Microsoft Project using the same mapping to correct
the data inaccuracy.

Task Description Enterprise Custom Fields (Task Type)
Currency Symbol Enterprise Custom Fields (Project Type)
User Rate Resource Standard Rate

User Hourly Cost Resource Standard Rate

User Default Billing Rate Resource Standard Rate

Task Level User Defined Fields (Proj/Task Cate- | Custom Fields (Task Type)

gory)

Note: If you attempt to map task level user defined fields to a single project level field in Microsoft Project,
the field data will not be updated and an error will appear in the update log file. This occurs because tasks
may potentially have multiple values for the selected field and can therefore not be mapped to the project
field, which can only receive one value.

Project Level User Defined Fields (Proj/Task Cat- | Project Category

egory) Project Keyword

Project Subject

Project Title

Project Comments

Project Author

Project Company

Enterprise Custom Fields (Project Type)

User Defined Fields (User Category) Enterprise Custom Fields (Resource Type)
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Available Mappings from Microsoft Project to Web TimeSheet

Microsoft Project Field (source)

Web TimeSheet Field
(target)

Project Keyword

Project Code
Project Description
Project Level User Defined Fields (Proj/Task Category)

Project Title

Project Code
Project Description
Project Level User Defined Fields (Proj/Task Category)

Project Subject

Project Code
Project Description
Project Level User Defined Fields (Proj/Task Category)

Project Category

Project Code
Project Description
Project Level User Defined Fields (Proj/Task Category)

Project Comments

Project Description
Project Level User Defined Fields (Proj/Task Category)

Project Company

Project Client
Project Level User Defined Fields (Proj/Task Category)

Project Work

Project Estimated Hours
Project Level User Defined Fields (Proj/Task Category)

Project Cost

Project Estimated Cost
Project Level User Defined Fields (Proj/Task Category)

Project Actual Hours

Project Level User Defined Fields (Proj/Task Category)

Task WBS Code

Task Description
Task Code
Task Level User Defined Fields (Proj/Task Category)

Task Duration

Task Estimated Hours
Task Level User Defined Fields (Proj/Task Category)

Task Work Task Estimated Hours
Task Level User Defined Fields (Proj/Task Category)
Task Cost Task Estimated Cost

Task Level User Defined Fields (Proj/Task Category)

Task Priority

Task Level User Defined Fields (Proj/Task Category)

Task Unique ID

Task Code
Task Level User Defined Fields (Proj/Task Category)

% Complete

Project Level User Defined Fields (Proj/Task Category)
Task Level User Defined Fields (Proj/Task Category)

Enterprise Custom Fields (Project Type)

Project Code

Project Description

Project Estimated Hours

Project Estimated Cost

Project Level User Defined Fields (Proj/Task Category)
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Microsoft Project Field (source) Web TimeSheet Field
(target)

Note: When you map from Microsoft Project custom fields to Web TimeSheet User Defined Fields, calculat-
ed fields are excluded.

Enterprise Custom Fields (Task Type) Task Description

Task Code

Task Estimated Cost

Task Estimated Hours

Task Level User Defined Fields (Proj/Task Category)

Note: When you map from Microsoft Project custom fields to Web TimeSheet User Defined Fields, calculat-
ed fields are excluded.

Enterprise Custom Fields (Resource Type) User Defined Fields (User Category)

Note: When you map from Microsoft Project custom fields to Web TimeSheet User Defined Fields, calculat-
ed fields are excluded.
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CHAPTER 8
Recommended Practices and Additional Notes
]

Recommended Practices

You should use the following recommended practices when transferring data between Web TimeSheet and
Microsoft Project.

If you are a Microsoft Project user integrating with Web TimeSheet for the first time:

» Use Microsoft Project to create and maintain your project profile/project information
e Transfer the projects to Web TimeSheet from Microsoft Project

» Enter time against the projects in Web TimeSheet

*  Only change the project information in Microsoft Project

If you are a Web TimeSheet user integrating with Microsoft Project for the first time:
« Transfer any existing Web TimeSheet project information to Microsoft Project for the first time only

» Following this initial transfer of project information, update the projects in Microsoft Project and
transfer the updated projects from Microsoft Project back to Web TimeSheet

« Use Web TimeSheet to enter time and transfer only time to Microsoft Project

When you create a new project in either application, be sure to use a unique name (that is, a project name
that does not already exist in either Project or Web TimeSheet). This will prevent naming conflicts, since the
first time you update a project from Project to Web TimeSheet, a new project with the same name used in
Microsoft Project will be created in Web TimeSheet, and vice versa.

We recommend that you create resources in Microsoft Project Server before running any updates (if you
have permission to add new resources in Project Server). If you update resources from Web TimeSheet to
Microsoft Project, the Integration Manager may prompt you to add resources that do not already exist.

Notes on Working with Externally Linked Projects

When working with a project in Microsoft Project that includes tasks that are linked externally, that is to a
task within another project, avoid naming the externally linked task with the same name as a task present at
the same level in the main project. If the tasks have the same name, data will not be transferred and the
Integration Manager will log an error.

Also, note that the Integration Manager does not support the transfer of embedded projects from Microsoft
Project Server.

Notes on Transferring Time Data with Web TimeSheet Billing Rates
Selected

Within Web TimeSheet, users can select a billing rate when entering time against a task. However, when
transferring time entries from Web TimeSheet, Microsoft Project does not support transfer of the associated
billing rates. If you are tracking costs for the project in Microsoft Project, it is important to note that the Web
TimeSheet billing rates will not be reflected in the cost data. However, the Integration Manager does support
mapping of Web TimeSheet values to the Microsoft Project Resource Standard Rate, which can be used
for cost tracking purposes, if desired.

Additionally, Web TimeSheet allows users to select more than one rate when entering time against a task.
When these time entries are transferred, the total of all hours entered for the task, regardless of the billing
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rate selected, will be transferred to Microsoft Project. For example, if 5 hours are entered against Task 1
using the Project Manager rate and 3 hours are entered against Task 1 using the Administration
rate, 8 hours will be transferred to Microsoft Project for Task 1.

Troubleshooting Issues involving the Integration Manager

If you encounter any of the issues listed below while using the Integration Manager, use the troubleshooting
information given below each heading to resolve the issue. If any of these issues persist, contact Replicon
Support. For information on how to do this, refer to Contacting Support on page 6.

Deleted Task Still Exists in Web TimeSheet after Update

If you have deleted a task in Microsoft Project and the corresponding task has not been deleted in Web
TimeSheet after an update, verify that the task is not selected on any users’ timesheets. If the task has been
selected on a user’s timesheet, Web TimeSheet prevents the task from being deleted, even if no time has
been entered against it. Have the user select another task or delete the timesheet row and then save the
timesheet. Update Web TimeSheet using the Integration Manager again and the task should be deleted
from Web TimeSheet.

Task Work Values Change when New Assignment Added using MSP API

If you add an assignment using Web TimeSheet Integration Manager for MS Project Server (MSPI) your re-
sulting Task Work field in Web TimeSheet will be different than if you added the assignment manually. This
is because MSPI uses MS Project Server's application programming interface (API) tool, which uses this
formula:

Task Work = Task Duration * 8 * Number of resources assigned to task
This results in Task Work being updated.

In contrast, manual entry uses this formula:

Task Duration = Task Work / (8 * Number of resources assigned to task)

This results in Task Duration being updated.

Cannot Connect to Project Server after restoring Database
If you restore the Project Server database on the Project server, you may be prevented from connecting to
Project Server via the Integration Manager, and receive the following error message:

The Microsoft Project server needs to be configured and connected. Please
go to the Configuration tab and enter the server information, your user-
name, password and click the connect button.

If this issue arises, to establish a connection, you should:

1. Reinstall the RPDS Extensions on the Project server. For information on how to do this, refer to In-
stalling an Integration Manager in Web TimeSheet’s online help.

Installing the RPDS Extensions creates tables and views in the database that are required to con-
nect the Integration Manager and the Project server.

2. Ifyou have created a dedicated username and password in your database for use in connecting to
Web Timesheet, ensure that:

« That username and password are assigned to the project database

That user has been assigned db_owner permission (if you are using a SQL database).
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